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Spreadsheet Software: A Spreadsheet software is an application software that is used for doing tasks such as numerical
and statistical calculations, sclentific calculations, data interpretation, Financlal and accounting data analysis, budgeting and
much more. There are different spreadsheet software such as Lotus 1.2.3, Micrasoft Excel, Corel Quattro Pro, OpenOffice
programs such as Calc and much more.
Features of a Spreadsheet Software: A spreadsheet software or a spreadsheet processor Is an application software that
Is used to organise and to analyse data In a tabular form.

» Spreadsheet software Is utllised For manipulation of data and creatlon of workbook Files comprising one/more

related worksheets.

» |t has many In-built tools, such as formulas and Functions that help in manlpulating data.
» It allows you to analyse data in a quick and presentable manner with the help of charts and graphs.
» |t has In-bullt Features, such as Autofill, that help In Filling in the serles of data, automatically.

Calc: It Is the spreadsheet compaonent of LibreOFffice. You can enter data (usually numaerical) in a spreadsheet and then
manlpulate this data to praduce certain results. Alternatively, you can enter data and then use Calc in a ‘What if...' manner
by changlng some of the data and observing the results without having to retype the entire spreadsheet or sheet,

Spreadsheaets, Sheats and Cells: Calc works with documents called Spreadsheets. Spreadsheets conslst of a number of
Individual sheets, each sheet contalning cells arranged In rows and columns. A particular cell Is Identifled by Its row number
and column letter. Cells hold the Individual elements « text, numbers, formulas and so on - that make up the data to
display and manipulate. Eoch spreadsheet can have up to 10,000 sheets and each sheet can have a maximum of 1,048,576
rows and 1,024 columns.

Calc Maln Window: When Calc Is started, the main window opens, The parts of this window are described belovs
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Title Bar: The Title bar, located at the top, shows the name of the current spreadsheet. When a spreadsheet Is newly
created from a template or a blank document, its name Is Untitled X, where X Is a number. When you save a spreadsheet
fFor the First time, you are prompted to enter a name of your choice.



» Menu Bar: When you select an item on the Menu bar, a
sub-menu drops down to show commands.

>

File: Contalns commands that apply to the entire
document; for example, Open, Save, Wizards, Export
as PDF, Print, Digital Signatures.

Edit: Contains commands for editing the document;
For example, Undo, Copy, Changes, Fill, Plug-in.

View: Contains commands for modifying how the
Calc user interface looks; for example, Toolbars,
Column & Row Headers, Full Screen, Zoom.

Insert: Contains commands For Inserting elements
into a spreadsheet; for example, Pictures, Frames,
Special Characters, Charts, Functions.

Format: Contains commands for modifying the
layout of a spreadsheet; for example, Cells, Page,
Styles and Formatting, Allgnment.

Sheet: Contains the most often used commands
for handling sheets, such as Insert and Delete Cells,
Columns, Rows and Sheets, as well as Comments
and Flll cells.

Data: Contalns commands For manipulating data
In the spreadsheet; for example, Define Database
Range, Sort, Statlstics, Pivot Tables and Consolidate.

Tools: Contains varlous Functions to help you
check and customise the spreadsheet; For example,
Spelling, Share Document, Gallery, Macros.

Window: Contains commands For the display
window; For example, New Window, Split.

Help: Contains links to the LibreOFfice help system
and other miscellaneous Functions; for example,
Help, License Information and Check For Updates.

» Toolbars: The default setting when Calc opens is For the
Standard and Farmatting toolbars to be docked at the top
of the workspace.

» Formula Bar: The Formula Bar Is located at the top of
the sheet in the Calc workspace. The Formula Bar Is
permanently docked in this positlon and cannot be used
as a floating toolbar. If the Farmula Bar Is not vislble, go to
View on the Menu bar and select Formula Bar. From left to
right, the Formula Bar consists of the following;

»

Name Box: It glves the current active cell refarence
using a combination of a letter and number, for
example, A1. The letter indlcates the column and
the number Indicates the row of the selected cell.

Function Wizard: Opens a dlalog from which you
can search through a list of avallable functions. This
can be very useful because it also shows how the
Functions are Formatted.

Sum: Clicking on the Sum icon totals the numbers
In the cells above the selected cell and then places
the total In the selected cell. IfFthere are no numbers
above the selected cell, then the cells to the left are
totaled.

Function: Clicking on the Function icon inserts an
equals (=) slgn Into the selected cell and the Input
line, allowing a Formula to be entered.

>

Input Line: Displays the contents of the selected
cell (data, fFormula, or Function) and allows you to
edit the cell contents. To turn the Input line into a
multiline input area for very long Formulas, click the
dropdown button on the right.

» Status Bar: The Calc status bar provides information
about the spreadsheet as well as quick and convenlent
ways to change some of its Features. The status bar has a
quick way to do some math operatlions on selected cells in
the spreadsheet.

» Sidebar: The Calc Sidebar (View > Sidebar) Is located on
the right side of the window. It is a mixture of toolbar and
dialog. It is similar to the sidebar in Writer and consists
of five decks: Propertles, Styles and Formatting, Gallery,
Navigator and Functions. The decks are described below:

» Spreadsheet Layout

>

Individual Cells: The maln sectlon of the workspace
in Calc displays the cells in the form of a grid. Each
cell Is formed by the Intersection of one column
and one row in the spreadsheet. At the top of the
columns and the left end of the rows are a serles of
header boxes containing letters and numbers.

The column headers use an alpha character starting
at A and go on to the right. The row headers use a
numerical character starting at 1 and go down. Thesge
column and row headers Form the cell references that
appear In the Name Box on the Formula Bar. IF the
headers are not visible on the spreadsheet, go to View
on the Menu bar and select Column & Row Headers.

Sheet Tabs: In Calc, you can have more than one
sheet in a spreadsheet. At the bottom of the grid of
cells In a spreadsheet are sheet tabs indicating how
many sheets there are in the spreadsheet. Clicking
on a tab enables access to each Individual sheet and
displays that sheet.

» Starting New Documants: You can start a new, blank
document In LibreOFfice In several ways.

>

>

Use File > New on the Menu bar and select the type
of document from the context menu.

Use the keyboard shortcut Cerl+N to create a new
document. The type of document created depends
on which LibreOffice component Is open and actlve,
For example, IF Calc is open and active, a new
spreadshect is created,

Use File > Wizards on the Menu bar and select the
type of document from the context menu.

If @ document is already open in LibreOffice, click
the New icon on the Standard toolbar and a new
document of the same type Is created In a new
window.

» Opening Existing Documents: You can also open an
exlsting document In ane of the following ways:

>

When no document Is open, click Open File or
Remote Files In the Start Center to reach the Open
dialog.

Go to File > Open or File > Open Remote File... on
the Menu bar the reach the Open dialog.

Use the keyboard shortcut Ctrl+O to reach the
Open dialog.



» |IF a document Is already open, click the Open icon
on the Standard toolbar and select from a list of
avallable documents from the Open dlalog.

» Click the small triangle to the right of the Open
lcon and select from a list of recently opened
documents.

» When no document is open, double-click on a
thumbnail of recently opened documents displayed
in the Start Center. You can scroll up or down in the
Start Center to locate a recently opened document.

» Saving Documents: You can save documents as follows:

» Save Command: Use if you are keeplng the
document, Its current Filename and location.

» Save to Remote Server: Use If your document Is
already stored In a remote server or will be stored
in a remote servear,

» Save As: Use if you want to create a new document,
or change the filename and/or file Format, or save
the File in a different location on your computer.

» Save a Copy: Use if you want to save a copy of
your current document and keep it open for more
editing.

» Save All: Use to save all the open files open In your
current sesslon.

» Save Command: To save o document IF you are keeplng
the document’s current Filename and locatlon, do one of
the Followlng:

» Use the keyboard shortcut Ctri+S.

» Go to File > Save, File > Save to Remote Servar,
File > Save a Copy, or File > Sava All on the Menu
bar.

» Click the Save Ilcon on the Standard toolbar.

» Save As Command: To save a document IF you want to
create a new document, or change the fillename and/or
file Format, or save the File in a different location on your
computer:

» Use the keyboard shortcut Ctri+Shift4S.
» Goto File » Save As on the Menu bar.

> Editing A Worksheet: When a new workbook Is opened,
the cells are set to a default slze, But sometimes, you may
want to modIfy the cell size, to add or delete more cells,
rows, columns, etc. Let us learn how to edit a worksheet.

» Editing Cell Contents: Sometimes, after entering
text In the cell, we need Lo edit the text. Faor this, we
can perform the Followlng two optlons:

e Replacing the Text: To replace the text of the
cell, we need to click on the cell and make It
active. Then, we can type the new text from the
keyboard to replace the old ane.

* Modifying the Text: IF we have typed incorrect
spellings or made any other error, in the content
of the text, we can modify it. We can do this by
using any of the following ways:

(a) Click on the cell to make It active, Then,
click on the formula bar and modify the
text.

(b) Make the cell active and then press the F2
key. Now edit the text.

(c) Double-click on the cell and edit the text.

» Formatting Data In a Worksheet: Data can be organised

into a general format in a worksheet by formatting it.
When you want to draw attention to some specific data
or want to make your worksheet visually appealing, you
should opt for formatting the data in a worksheet. For
example, If you want to highlight the column headers
of the worksheet, or want to change the colour of some
specific cells to draw attention, you can do this by using
different fFormatting options avallable In calc, to Format
data such as text, number and date. Let us learn those
Formatting optlons in detall here.
Formatting Font: The options For Fermatting the Font are
fFound under the Tools -> Options-> Fonts.
We use the given options to work with the font of the
data. We can perform the following operations using the
Font Group:

» Changing font

» Changing font size

» Changlng font colour

» Changlng text style
Creatling Serles/Autofill: Pattern-based data Is recognised
by calc Instantaneously and can be used to Ffill.up data
automatically, The calc Autofill Feature can be used to
populate a range of cells with elther a repeated value or a
sarles of numaeric values, For exaomple, number series, dates,
days of the week, months In a year and much more.

» Autofill Dates and Times: As dates and times are stored

in calc as numbers, these can also be used with the Autofill.
By default, IF we just type In a single date or time and
drag the Fill handle, dates and times will get completed
in @ saries, by adding one day (For dates), or one hour (for
time). However, for dates, there are addltlonal Autofill
optlons. Apart from the four optlons for simple numbers,
there are some more optlons as Follows:

> Fill Days: Look for a pattern In the day when filling
the selected cells.

> Fill Weekdays: Look For a pattern in the day
when Filling the selected cells, but do not Include
Saturdays or Sundays In the serles.

» Fill Months: Look for a pattern in the month when
Filling the selected cells.

> Fill Years: Look for a pattern In the year when filling
the selected cells.

Formulas in Calec: Formulas are used to carry out
calculations that involve baslc arithmetlc operations such
as addition, multiplication, subtraction and divislon in calc.
You must have used Formulas in mathematics, but in calc,
formulas are written in a different manner.

» Calc Provides Following Types of Formulas:

> Simple Formula: A simple Formula Is an expression
that Is made up of numbers, arithmetic operators,
cell addresses and parentheses.

e Components of a Formula: The following are
the components that make up a basic Excel
Formula.

* Oporators: They are speclal characters like +,
-.><,./.", ", % that specify the arlthmetic
calculation to be carried out.



o Cell References: These are the cell addresses or
the cell ranges that contain the values to be used
in calculations, For example, A3, B2, A2:A6.

e Constants: They are the fixed numeric or string
values, for example, 56,789 (numeric), “Hello”,
"Welcome" (string) that are used in calculations.

e Functions: They are the in-built formulas whose
meaning and purpose are already defined in Calc
2010, For example, Sum, Max, Min, Sub and many
more.

o Equal to (=) Symbol: It I3 used to start an Calc
Formula.

o Parentheses: They are used to enclose cell
ranges, for example, Sum (C1:C4).

» Compoundor Complex Formula: Compound Farmula,
also known as Complex Formula contains more than
one operator. A formula to calculate simple interest
like (Principal amount * Rate of interest * Time)/100 I8
an exomple of a compound Formula.

» Text Formulas: Text Formulas are used to add
characters and string values, Jolnlng of strings I8
known as Concatenatlon. Strings can be added using
& symbol, Perfarm the below mentioned steps to
Joln twro strings:

o Step 1: Type two strings 'l Love’ and "My Country’
in cells A1 and B1, respectively,

o Step 2: Now for adding these two, write the
Formula =A18" “&B1 in the cell C1 and press the
Entar kay.

o Step 3: 'l Love My Country’ will be displayed In
the cell C1.

» Cell Reference: Cell Address, in a Farmula, Is known as Cell
Reference. Cell Reference Is used For Identifying a cell or a
range of cells, In a worksheet, References help to look For
the values which are to be used in a fFormula In different
parts of a worksheet,

> Types of Cell References: There are three different types
of cell references, in calc

>

Relative Cell Reference: It is based on the relative
position of the cell contained In the formula. A
spreadsheet cell reference, by default, Is known as
relatlve. When a formula Is copled and pasted to
other cells, the cell reference in the formula or the
Function changes relatively to the location where it
is copled. Far example, if a formula =SUM(C3:G3) is
written In the cell H3 and Is copled to H4, then the
Formula will automatically change to sSUM(C4:G4)
For the cell H4.

Absolute Cell Reference: When the cell address Is
not changed In a formula, while copying It to other
cells, It Is known as absolute cell reference. You can
add a dollar sign (S) in front of a row address and
column address to make the absolute cell reference
of a cell, IF a cell contains a value that needs to
remaln fixed in a fFormula, we should specify the
cell reference of that cell as absolute cell reference.
SHS2, SAS4 are some examples of absolute cell
references.

Mixed Cell Reference: It Is a combination of both,
l.e, absolute and relative cell references. A mixed
cell reference I8 elther an absolute row and a
relotlve column or on absolute column and a relative
row. We add the $ sign befare the column name
to create an absolute column or before the row
number to create an absolute row.

» Functlons: A Function Is a pre-defined Formula that
performs calculatlons using specific values in a particular
order, Functlons can be used to carry out simple as well as
complex calculations. Functions save time as one does not
need to write the Formula. Also, writing down Formulas
For dolng calculations can be tedlous and complicated at

times.

» Some Commonly Used Functlans: There are many pre-defined Functions In calc which we can use. The following table Usts
some commonly used Functions In calc, along with thelr purpose and examples.

Function Name Purpose Example
SUM(range) It calculates the sum of a glven range, =SUM(A4:B6)
AVERAGE(range) It calculates the average of a glven range. =AVERAGE(A4:B6)
COUNT(range) It counts the number of cells In range. =COUNT(A4:B6)
TODAY() It displays the current date. =TODAY()
INT(number) It rounds off a number to the nearest Integer. =INTEGER(102.78) or

a|NTEGER(C5)
ODD(number) It returns a number rounded up to the nearest odd Integer. | =ODD(102.78) or
=0DD(CS)
ROUND(number, num_digits) | It rounds off 3 number to specified digits, =ROUND(234.567,1) or
=ROUND(CS)
SQRT(number) It returns a square root. =SQRT(16) OR
=SQRT(CS)

> Autosum Feature: The AutoSum feature In calc Is used to automatically add the values, given in the selected cells. A
range of cells can easily be added using the AutoSum option on the Formulas tab. AutoSum recognises the data that
Is consecutively entered and when it sees an empty cell, thse AutoSum stops. We can also use the AutoSum Feature to

perform other calculations, such as AVERAGE, COUNT, MAX and MIN.



» Embedding Charts in 8 Worksheet: A chart is a graphlcal
representation of data entered In a worksheet that makes
it easier for a user to comprehend data. Charts help you to
analyse and compare the data, instantly. Click the Insert
Chart Icon on the Standard toolbar.

» Keyboard Shortcuts:

Ctrl + Home Move cursor to Al

Ctrl+ End Move cursor to last cell with data
Inside

Home Move cursor to first cell of the row

End Move cursor to last cell of the row

Shift + Home Select from current cell to Arst cell
of the row

Shift + End Select from current cell to last cell of

Shift + Page up

the row
Select from the current cell up a page

Shift + Page Select fram the current cell down a
down page

Ctrl+ 1 Open Farmat cells

Ctrl + Shift « 1 | Two decimal places

Ctrl + Shift + 2 | Exponential format

Ctrl + Shift + 3
Ctrl + Shift + 4
Ctrl + Shift + 5
Ctrl + Shift + 6

Date format
Currency format
Percentage format
Standard format

Ctrl + F1

F2

Ctrl + F2

Shift + Cirl + F2
Cerl + F3

Shift « Ctrl + F4
F4

F5

Shift + F5

Shift + Ctrl + F5
F7

Shift + F7

Cerl + F7

F8

Ctrl + FB

F9

Ctrl + F9

Ctrl + Shift + F9
F1

Shift + F1

Shift + Ctrl + F11
F12

Ctrl ¢ F12

Shows comment

Enter Edit mode

Open Function wizard
Move cursor to Input lne
Open Define names
Show/hlde Database explorer
Rearrange references
Show/hide Navigator
Traces dependents

Mowes cursor to Sheet area
Check spelling

Traces precedents

Opens Thesaurus

Enable/dlsable additlonal selection
mode

Highlight cells contalning values
Recalculate formulas in current sheet
Update chart

Recalculate formulas In all sheets
Open Styles

Create a document template

Update the template

Group the selected daota range
Ungroup the selected data ranpe

2| Multiple

Practice Exercise

Q 6. Method to open LibreOffice Calc In Windows Is:

N Choice Questions

a. double-clck the shortcut of LibreOffice Calc on

Ql

Q2.

Q3.

Q4.

Which of the following help us to perform varlous
calculations?

a. Writer

C. Impress

Spreadsheet is used for:
a. managjng financlal and accounting documents
b. creating data reparts

c. data analysis

d. All of the above

Spreadsheet packages
........................... formulae.

a. Mathematical b. Statistical
c. Both a. and b, d. None of these

Which of the following is not a Spreadsheet
Software?

a. Microsoft Excel
c. OpenOffice Calc

b. Spreadsheet
d. None of these

also provide built-in

b. LibreOffice Calc
d. None of these

11 | U O Operating System, the LibreOffice
gets installed by default.
a. Windows b. Unux (Ubuntu)

c. Both a.and b, d. None of these

Q7

Q8.

Q9.

Q 10.

desktop
b. click the window menu, select
applcation, then click LibreOffice Calc
c. Both a. and b.
d. Nane of the above

LIbreOffice

Quick Access Tool bar Icon s present on
a. Menu bar b. Standard Tool bar
c. Title bar d. Status bar

Default name of spreadsheet open In LibreOffice
CALE I8 crussnsemainsaenmnn .

a. untitled X, where X Is a number

b. calc X. where X [s a number

C. spreadsheet X, where X Is a number

d. None aof the above

In LibreOffice Calc Scroll bar is present on
ERST—— | ; |, Jea————— -, )" [T (0,2
a. left, right b. right. top

C. bottom, right d. top, bottom

By default ..................u........ Sheets is/are present in
LibreOffice Calc Spreadsheet.

a. 1 b. 2 c. 3 d 4



Q 1.

Ql2.

Ql3.

Q 4.

Q 15.

Q 16.

Q17.

Q18.

Q19.

Q 20.

Q21

Q22

Q23.

Q 24.

Q 25.

Q 26.

In LibreOffice Calc, Row headings are in
a. numbers b. alphabets

¢. alphanumeric d. None of these
........................... contains the menus with commands
for various tasks.

a. Status bar b. Standard Toolbar

¢. Formatting Toolbar  d. Menu bar
ceccrnsnnnesncennnannnennes 18 lOCAted just below the Title bar.
a. Standard Toolbar b. Menu bar

c. Formatting Toolbar  d. None of these
........................... Is the shortcut to exit LibreOffice.
a. Ctrl + Q b. Ctrl + E

¢, Ctrl + X d. None of these

Cut, Copy, Paste options are available in
........................... menu

a. Flle h. Edit c. Format d. View
Insert Cells, Insert Rows, Insert Columns options are
available IN..ensmiasinssiscs menu.

a. File b. Insert  c. Sheet d. Data
Placing the mouse cursor over any icon displays a
small box called....... G ..... which gives a brief
explanation of the Icon.

a. Toolbar b. Toolbox

c. Tooltlp d. All of these
........................... shows the address of Active Cell.

a. Name Box b. Current Cell

c. Formula bar d. None of these
The Worksheet In Calec is also referred to as

llllllllllllllllllllllllllll

a. Warkbook b. Spreadsheet

c. Sheet d. None of these
Columns are ...cccevenrevrinenersnnens in the table.
a. horlzontal b. vertical

c. dlagonal d. None of these

Column Heading of 27th Column in Calc sheet Is

llllllllllllllllllllllllllll

L X d. ZA

The intersection of a row and column is called
a. Cell Address b. Cell

. Point of Intersection  d. None of these

Which of the following Is invalid Cell Address?

a. Al b. 2247

c. 91A d. None of these

Which of the following is not true about Currently
Selected Cell?

a. Currently Selected cell Is called Active cell

b. Currently Selected Cell's Address Is visible In Name
box

c. Currently Selected Cell have thick border

d. Naone of the above

Address of cell formed by intersection of tenth
column and nineteenth row is ........ccuus

a. K19 b. 19K c. J19 d. 19J

Cell address of first row and first column
a. Al b. 1A

c. A-1 d. None of the abave

Q27.

Q 28.

Q 29,

Q 30.

Q3L

Q 32.

Q 33.

Q 34,

Q 35.

il

Which key combination moves the active cell
(Selected Cell) to the end of the data range In a
particular direction?

a. Ctrl + Home b. Ctrl + End

c. Ctrl + Arrow keys d. None of these

Which key combination moves the active cell
(Selected Cell) to Al cell?

a. Ctrl + Home b. Ctrl + End

c. Ctrl + Arrow keys d. None of these

Which key / key combination moves the worksheet
one screen up?

a. Ctrl + Up Arrow Key  b. Ctrl + Page Up

c. Page Up d. None of these

A block of adjacent cells In a worksheet which Is
highlighted or selected Is called ........occcciiniiinnnnin :

a. Block of cells b. Range of cells

¢. Both a. and b. d. None of these

In LibreOffice Calc, ......coccrvriveceninnnns 1S 3Ny text
entered by using a keyboard.

a. Values b. Poster

c. Label d. None of these

By default labels are ........ccccrnninnrnccanns allgned.

a. left b. right

c. top d. None of these

The data consisting of only numbers are called
a. Labals b. Values

c. Functlons d. None of these

By default Values are .....c..c.ooivvinnnennn aligned.

a. top D. right

c left d. None of these

Any expresslons that begins with an equals "=’ |s
AR 85 o cvnsuiminississsinsas

a. function b, formula

c. both a. and b. d. None of these

Fill in the Blanks

N Type Questions

Q 36. The column immediately next to column “Z° Is

SEEE RN AR AR B RN R RN

Q 37. The default extension of a workbook created using

Q 38.

a LibreOffice Calc spreadsheet Is........cccviinvenerinees :

The spreadsheet feature used to continue the
series is called as .....coovvvverrenisrensnns ‘

Q 39. The formula "=MIN(C1:C5)" stored In cell C6 when

Q 40.

Q 4l

Q 42.

copled to cell D6 changes to ........c.cvvnviinninens :

The formula in cell A2 is =B2+C3. On copying
this formula to cell C2, C2 will change to

The cell address of the cell formed by the
intersection of the ninth column and the eighth
row will be ......ovcviieirerrnnnnne.

$A19B2 is an example of
referencing in spreadsheet software.

---------------------------



7| Assertion and Reason
N Type Questions

Directions (Q. Nos. 43-47): In the questions given

below, there are two statements marked as Assertion

(A) and Reason (R). Read the statements and choose the

correct option.

a. Both Assertlon (A) and Reason (R) are true and
Reason (R) Is the correct explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true. but
Reason (R) Is not carrect explanation of Assertion (A).

c. Assertlon (A) Is true, but Reason (R) Is false.

d. Assertion (A) Is false. but Reason (R) Is true.

Q 43. Assertion (A): A spreadsheet software or a

36. AA

37. .ods

38. Fill Handle
39. =MIN(D1:D5)
40. =D2 + E3
4]1. I8

42. mixed

43. (d) 44. (b)

45, (c)

46. (b) 47.(d)

(2| Case Study Based

N Questions
Case Study 1

A cell range in a spreadsheet file is a collection of

Q 44,

Q 45.

Q 46.

Q47.

spreadsheet processor is a system software that Is
used to organise and to analyse data in a tabular
farm.

Reason (R): Spreadshecet software is utilised for
manipulation of data and creation of workbook
files comprising one/more related warksheets.
Assertion (A): Aworksheet is the actual area where
you work in calc. It is like a page in a notebook,
where we write and note down our Information.
Reason (R): A workbook is actually like a notebook
that has multiple pages with cells In it. It contalns
three worksheets by default, but more worksheets
can be added depending upon the requirement.
Assertion (A): The Qulick Access toolbar cantalns
the commands that are frequently used such as
Save, Undo and Redo.

Reason (R): The Name box displays the cell address
of an active cell. A cell address is made up of row
number and column number such as C7, DB, etc.
Assertion (A): Cell is the area which accepts a value
such as number, text or formula. The intersection
of a row and a column makes a cell.

Reason (R): The Status bar displays the sheet
information as well as the insertion point location.
From left to right, this bar contains the total
number of pages and words in the document and
other Information such as language used, etc.
Assertion (A): The optlons for formatting the font
are found under the Font group on the Insert tab.
Reason (R): The Insert worksheet button on the
sheet tab is used to insert a new warksheet in the
viorkbook.

Answers o

d) 3.(c)
) 9.(c)
. (a) 15.(b)

( 4. (d)
(
(
.(b) 21.(a)
(
(

5.(b) 6. (c)

10.(a) 11.(a) 12. (d)
16.(c) 17.(c) 18.(3)
22.(b) 23.(c) 24. (d)
27. (c) (c)
(

33.(b)

28.(a) 29.(c) 30. (b)
34.(b) 35.(b)

selected cells, This range 18 usually symmetrical
(square), but can exist of separate cells just the
same. A cell range can be referred to in a formula
as well.

[n a spreadsheet, a cell range is defined by the
reference of the upper left cell (minimum value)
of the range and the reference of the lower right
cell (maximum value) of the range. Eventually
separate cells can be added to this selection,
then the range is called an irregular cell range.
In spreadsheet, the minimum and maximum
value are included. That's different from a
mathematical range, in which it is a collection
of values belween a maximum and o minimum
value,

When entering a range of cell references as an
argument for u function or when creating a churt,
in addition to typing in the range manually, the
range can also be selected using pointing. Ranges
are identified by the cell references or addresses
of the cells in the upper left and lower right
comners of the range. These two references are
separated by a colon. The colon tells spreadsheet
to include all the cells between these start and
endpoints.

Q1. Range of cell C2 : C7 Includes ......cccuirincnncisnnnns

cells

a. 4 b. § . 6 d 7

Q2. C3:F3isanexample of.....cccccinnnnennniirnnens

a. Column range

b. Row range

c. Row and Column range
d. None of the above

Q3. Cell Range A1:D3 consist of ....ccoiiiiinmnesisiannnns

cells.

2 o b. 4 c. 12 d. 10

Q4. ...oinnirnrcnnnnnnennns K€y i5 used to select more

than one range uf cells’in a worksheet.
a. Ctrl b. Shift
c. Alt d. None of these

Q5. What Is the address of the first cell represented

by Range D34 : F407?

a. F40 b. D34 c. Dad d. F34



work had to be done using pencil and could only

Answers ®

be penned when one was sure that the data is not
5. (b) going to change. The introduction of spreadsheet
on compulers revolutionised the world of
number juggling. It allowed user (o quickly enter
data electronically and edit it as required. Even
complicated calculations could be performed and
the data could be presented in the form of graphs
and charts for easier comparison of two sets of
data.

Q1. On aspreadsheet the active cell is indicated by:
a. a dotted border
c. a binking border d. by Itallc text

Q 2. Which of the following keyboard shortcut can
be used for inserting comment?

a. Ctri+Alt+C b. Shift+Alt+C
c. Ctri+Shift+C d. Ctri+Alt+5

1. (c) 2.(b) 3.(¢) 4. (b)

Case Study 2

Operators in Spreadsheet specifies the type of
calculation to be performed on a given set of
values. Obviously not restricted (0 numeric
values only, we can use operators over different
data types other than numeric (for example,
Text/Character data type). Spreadsheet has a
rich variety of operators to perform calculative
actlions on a given set of data.

Arithmetic Operators are used for arithmetic
operations like addition, subtraction,
multiplication, division, etc. Arithmetic operators
follow the order precedence. Exponential and

b. a dark wide border

Percentage operators have the highest precedence Q3. Which key Is used For help in Ms Excel?
and then Multiplication and Division followed by a. F2 b. F1
Addition and Subtraction. Logical or Comparison ¢ F3 d. None of These
Operators are used in Spreadsheet (o logically Q4. Which shortcut key is used to insert cell in
compare the two values (numeric or text). LibreOffice Calc?
Q1 LibreOffice Calc Uses ..cc.uunmissenmimnniinnins oparator a. Ctrl -+ b. Ctrl ¢+ c. Shift ¢+ d. Shift +
for division. Q5. Which of the following is not a valld zoom
0. I b. \ percentage In Excel?
Gl d. None of these a. 10 b.400 c 100 d. 300
Q2. Which of the following symbol is used for A
exponentiation (power) in LibreOffice Calc? " nswers .
8, b. /¢
1. 2. 3. (b 4. (b 5.
" d. None of these ) 2 ) ) @
Q3. Evaluate the following formula: Case Study 4
=(5°4)"2 LibreOffice Cale is the spreadsheet component of
a. 40 b. 80 the LibreOffice software package. After forking
c. 400 d. Nane of these from OpenOffice.org in 2010, LibreOffice

04. Evaluatﬂ th@ fnuuwing fun‘“uln: CHJC UﬂdchEﬂt il ﬂlﬂSSiVE I'C-WDI']‘( ’Df CK[CI‘TIII]

@ 16/(4"2) reference handling to fix many defects in formula

3.0 b 1 - 16 4 B calculations involving external references and to

' ' ' _ ' boost data caching performance, especially when

Q5. E:al;mztﬂ ;!the following formula: referencing large data ranges.

ml+2"2-

5 b. 2 3 4 Calc is the spreadsheet component of LibreOffice.

' ' ‘ ' Spreadsheets allow us (o organise, analyse

Answers ® and store data in tabular form. Furthermore in

a spreadsheet we can manipulate this data to
produce certain results, Other features provided
by Calc include:

Case Study 3 « Functions, which can be used 1o create
formulas to perform complex calculations on

1. (c) 2.(c) 3.(c) 4, (b) 5. (c)

Spreadsheet as the name suggesis is one big
table or chart with data spread all over the page.
Before the advent of compuler programs, paper
spreadsheets were used to record data for financial
analysis. The accountant had to spend several
hours recording data in tiny rows and columns
and calculating results using a calculator. All the

data.

* Database functions to arrunge, storc and filter
data.

* Dynamic charts giving a wide range of 2D and
3D charts.

 Ability to open, edit and save Microsoft Excel
spreadsheets.



Q L Cell Al contains the number 10 and B1 contains 5.

What will be the contents of cell C1, if the formula

Answers s

=A1+B1°2"3 is entered in cell C1? 1. Cell Reference Is used for Identifying a cell or a
Q 2. The contents of Cell A1, B1, C1 and D1 are 5, -25, range of cells, in a worksheet. References help to

30 and -35, respectively. What will be the value look for the values which are to be used in a formula

displayed in cell E1 which contains the formula in different parts of a worksheet

=MIN(A1:D1). 2. There are three different types of cell references:

. , (I) Relative cell reference

Q3. Cell D5 contains the formula =$B§S+C5 and this Gl Asslutecell refarence

formula is copled to cell ES, what will be the copled (iii) Mixed cell reference

formula in cell E5? 3. Ifaformula =SUM(C3:63) Is written In the cell H3 and
Q4. Cell D5 contains the formula =$B5 + C5 and this Is copled ta H4, then the farmula will autoamatlcally

formula is copled to cell E5, what will be the copled change to =SUM(C4:G4) for the cell Ha.

formula in cell E57 4. When the cell address is not changed in a formula,
Q 5. Cell D5 contains the formula =$B5 + C$5 and this while copying It to other cells, It s known ag absolute

formula is copied to cell E6, what will be the copled cell reference.

formula in cell E6? 5. Mixed cell reference Is a comblnation of both, Le.

Case Study 5

Cell Reference: A cell reference 1n cale refers to
the value of a different cell or cell range on the
current worksheet or a different worksheet within

absolute and relative cell references. A mixed cell

Qe

Answers o reference is either an absolute row and a relative
column or an absolute column and a relative row.
1. 50
5 .35 ? | Very Short Answer
3, =5B55+¢D5 N Type Questions
4. =585 + D5 QL What do you mean by Spreadsheet/Electronic
5. aSB5 + DS5 Spreadsheet?
Ans. A spreadsheet is a grid which Interactively monages

and orpanises data In rows and columns. It Is also
called as Electronic Spreadsheet.

In which operating system LibreOffice installed by
default?

Ans. Linux(Ubuntu
the spreadshect. A cell reference can be used us o ( |
: : . Q 3. Name any three components of LibreOffice.
variable in a formula. The simplest cell reference
Ans. Three components of LibreOffice are;

appears as o simple mention of the referred cell
after an equal sign. For example (=C5) refers to
the value within cell C5. It means that the value

(1) LibreOffice Calc
() UbreOffice Writer
(i) LbreOffice Impress

of the current cell is equal to the value of C5.The Q 4. How to start the LibreOffice Calc In Windows?
notation (=A1:C6) refers to cell range Al through Ans. Steps to start the LibreOffice Calc in Windows are:
C6. Independently it doesn’t mean anything and Double-click the shortcut of LibreOffice an the
cale will return standard error #VALUE! You can Desktop.

find more information about standard calc errors OR

in our calc Guideline for Professionals: Don't Click the window menu. select LibreOffice
Neglect cale Errors! But when the reference to application, then click LibreOffice Calc.

u range is used in a function, the magic happens. Q5. How to start the LibreOffice Calc in Linux?

For example =SUM(A1:C6) will return the Ans. In Ubuntu Linux. find the Calc Ilcon on application

total value of the cell range Al through C6 and
mAVERAGE(A1:C6) returns the average of this
cell range.

Q 1. Define Cell Reference.

Q6.

Ans.

launcher or search it by clicking on "Show
Application® and then click on icon.

What Is a chart?

A chart s a graphical representation of data entered
In a worksheet that makes It easler for a user to

Q 2. Name all the types of cell references.
Q 3. Give an example of Relative cell reference.
Q 4. What do you mean by Absolute cell reference?

Q 5. Define Mixed cell reference.

comprehend the data. Charts help you to analyse
and compare the data. instantly.

Define the term workbook.

A workbook s a collection of worksheets.

Q7.

Ans.




Q8.

Ans,

Q9.

Ans.

Q 10.
Ans.

Q 11.
Ans,
Q12
Ans,
Q13.

Ans,
Q4.
Ans,

Q 15.

Ans.
Q 16.

Ans,
Q17.
Ans,

Q 18.
Ans.

Q19.

Ans,
Q 20.
Ans.
Q21
Ans.

Reena is new to Calc. Her instructor has asked
her to open Calc on her PC and questioned about
active cell. Help Reena in identifying the active cell
on her screen,

An active cell is a cell with heavy black colour
boundary.

What is the default alignment of number, text and
formula in a spreadsheet?

Default alignment of text or label entry is left
alignment and for numbers and formula it is right
allgnment.

Elaborate the formatting necessary.

With formatting, we can make some data to be
bolder, ratated or In different colour. So, basically

formatting provides worksheet a neater and more
leglble outlool.

Soham has clicked on the cell residing at the
intersection of first row and ninth column. What
will be the address of the selected cell?

Firat row and ninth column address will be 1.

In Calc, how many ways are there to express/
format a number?

Numbers In Calc can be expressed In many different
formats like date, time, percentage or decimals.

Name the toolbar of spreadsheet which has all the
options of changing the font properties.

Formatting Toolbar
What do you mean by relative referencing?

Cell referancing in which the cells are referred by
thelr relative position In the worksheet relative to a
particular cell is called relative referencing,

The cell A1 has value Monday. If you are asked to
click and drag the Fill handle of A1 downside then
what will be the contents of cellA2,A3, A4 and A5?

Cells A2, A3, A4 and A5 will contaln Tuesday,
Wednesday, Thursday and Friday respectively.

If = 6 -5 °2 Is entered In a cell, then what will be
the cell content?

-4 viill be contained in cell as a result.

What do you mean by Tooltip?

When we place the mouse cursor over any lcon, It
displays a small box called a tooltip. It gives a brief
explanation of the icon functlon.

What do you mean by Worksheet in Calc?

The worksheet in Calc is also referred to as
spreadsheet. Each sheet can have many Individual
cells arranged In rows and columns.

Name the baslc element or bullding block of
spreadsheet.

Cell

What do you mean by Cell?

The Intersection of a row and column Is called a cell
What do you mean by Active Cell?

The selected cell is called Active Cell It is always
highlighted. with a thick border. The address of the
active cell is displayed in the name box

Q 22.

Ans.
Q 23.
Ans.
Q 24.

Ans.
Q 25.

Ans.

Q 26.

Ans.
Q 27.

Ans.
Q 28.

Ans.
Q 29.

Ans,
Q 30.
Ans.

QL

Ans.
Q 32.

Ans.

Q 33.
Ans.

Q 34,
Ans.
Q 35.
Ans.

Name the bar which is located at the top of the
LibreOffice Calc window.

Title bar
Define Title bar.
Title bar shows the name of the current spreadsheet.

What is the default name of the first file opened In
LibreOffice Calc?

Untitled 1
Write the cell address of the following:

(i) Seventh column and tenth row.......
(if) Tenth column and nineteenth row........

() GI0

(i) )19

Write the cell address LK89 is situated in row
numbet......... and column letter........ .

B9 and LK

Write the shortcut to move the cell to the end of

the data range in a particular directian.

Ctrl + Arrow Keys

Write the shortcut to move the cell pointer to Al
position.

Ctrl + Home

Write the shortcut to move the cell pointer to
bottom right cell of the data range.

Ctrl + End
What do you mean by Range of cells?

A block of ad|acent cells In a worksheet which Is
highlighted or selected Is called a range of cells. For
example, A1:C3.

Identify the range of cells as Row range, Column
range, Row and Column range, C9 :J9

C9:J9 -~~~ - Row Range

Name the two types of data that can be entered
in a cell.

Two types of data that can be entered in a cell are:
(I) Label (I Values
(i) Formulag
What do you mean by Formula in Calc?

Any expressions that begins with an equals to sign
(‘=') is treated as formula. For example =A1 + B1

Evaluate the expression = (5°4)"2
400
Define Label

If we fargot to put the ‘=" before the farmula, it veill
be treated as a Label

2| Short Answer

N\ Type Questions

QL

Ans.

Write three uses of spreadsheet.
Spreadsheet is used for:
(I) Managing financlal and accounting documents.
(i) Creating data reports. generating invoices.
(I} Data analysis from sclentific and statistical
researches.



Q 2. Listanyfour activities which can be done accurately
or efficiently on LibreOffice Calc.
Ans. Four activities are:
(I) Flleering the requlred data.
(i) Calculations using formula and functions.
(i) Check the validity of data.
)

(lv) Arranglng data In ascending and descending
order.

Q 3. Write any four Spreadsheet software.

Ans. Four Spreadsheet software are:
() Microsoft Excel
(I) UibreQOffice Calc
(i) OpenOffice Calc
(lv) Apple Inc. Numbers
Q4. Name any eight parts of User interface of
LibreOffice Calc.
Ang. Elght parts of User Interface of Libre Office Calc are:
(I) Quick Access Tool bar  (ll) Title bar

(i) Ribbaon (iv) Control Buttons
(v) Name Box (vl) Formula bar
(vil) Formatting Tool bar  (vill) Zoom Control
(Ix) Column Headlng (x) Row Headlng.

Q 8. Name any four items/options available on Menu
bar.

Ans. Four items/options avalloble on Menu bar are |
(write any four)

(I) File () View
(1) Edit (lv) Format
(v) Insert (Vi) Styles

Q 6. Name and explain in brief any two toolbars which
provide a wide range of common commands and
functions in LibreOffice Calc.

Ans. Two toolbars are:

(I) Standard Toolbar: The standard toolbar shows
the lcons far most common aperations, such as
editing. arranging, filtering, etc.

() Formatting Toolbar: It Includes buttons for
font selectlon, size of text, allgnment cell value
formatting and indentation, etc.

Q 7. Differentiate between Row and Column.
Ans. Differences between Row and Column are:

Row Column

The haorizontal Unes Iin | The vertical Unes In
warksheet are called worksheet are called
rowWs. columns.

Row headings are Column headings
represented by are shown by Capital
numbers Uke 1, 2. 3, etc. | Alphabet Uke A, B, C, etc.

Q 8. Write the cell address of the following
(I) First row and first column ...........
(i) First column and Last row ............

(iii) First row and last column ...........
(iv) Last column and first row........

Ans. (I) Al () A104B8576
(iii) AMJIY (iv) AMJT

Q 9. Identify the following range of cells as Row range,
Column range, Row and Column range.

(i) Al:A7 (ii) AL : D1
(iii) A3 :D7 (iv) B4 : B12
Ans. (i) Al1: A7 ————~- Column Range
(i) A1: Dl === ~~ Row Range
(i) A3: D7 - ---- Row and Column Range
(iv)B4:B12 -~ --- Column Range

Q 10. Evaluate the following equations using operator
precedence and then test the result in the

spreadsheet.
(i) 1+272-2 (ii) 4°3/2

Ans. () 3 () &

Q 1L Write the steps to Insert a column before any
column.

Ans. To insert 8 column before any column, position the
cursar on any cell of the column befare which you
want to Ingert the column and select

Sheet — Insert Columns — Columns — Columns Left

Q 12. Write the output of the following on the basls of
the given screenshot.

lil] Untisied 1 - LibraOffico Cale O X
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LLElJ phalion Sans
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Show1 Dol 3| Dalewit | English (India) | mf | @ R | S

(i) =COUNT(A1:A4)
(i) =COUNT(A1:C1,B2)
(ili) =COUNT(B1:C3)
(lv) =COUNT(A1:A3,C1:C3)
Ans. (i) 3 (1) 4
(iii) & (lv) 6
Q 13. Write the steps to format a cell to the required
number of decimal places.
Ang. The steps to format a cell to the required number of
decimal places are:

(i) Select the range of cells

(i) Open the ‘format cells dialog' box
(iif) Click the 'Number' tab

(iv) Select the 'Number
(
(

v) Change the decimal places as required
vi) Click "OK’



Q 14.
Ans.

Q15.

Ans.

Q6.

Write the steps to format a range of cells as text.
Steps to format a range of cells as text:

(i) Select the range of cells

(I) Open the ‘format cells dlalog’ box

(i) Clck the Number tab

(iv) Select Text

(v) Cliclk 'OK'

(vl) Enter numbers

Aman is writing telephone number along with STD
code (starting from zero '0'). He noticed that the
first digit zero ('0'), disappears from the telephone
number. Write the reason for this. What can be
done to store telephone number starting from
zero in a cell?

This |s because the telephane number Is stored as a
numeric value and the numeric value does not have
a preceding zero. We can store telephone number
starting from zero In a cell by formatting the cell
conslsting of telephane number ag ‘text’

How will you find the lowest score in English and
Maths using functions?
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Q 19. What do you mean by absolute referencing in Calc?

Ans. In Absolute referencing, a S symbol is used before
the calumn name as well as row number to make It
constant in any formula. Far example, SC512, SDS5,
etc. In this case, even If you drag your farmula In any
direction, the cell name remains constant.

Q 20. Identify the types of referencing from the following:
(i) =C1 (ii) =D$2

(iii) =3W2 (iv) =$E$4

Ang.

Q2L

Ans,

Q 22.
Ans.

(I) Relative Referencing
(i) Mixed Referencing
(iii) Mixed Referencing
(iv) Absolute Referencing
Name any four types of charts that can be created
in OpenOffice Calc.
Four types of Charts are:
(i) Bar Chart (i) Column Chart
(1) Ple Chart (iv) Line Chart
Write the steps to create column chart in Calc.
Steps to create column chart In Cale are:
() Select the range of data.
(i) Click an Insert -» Chart
(i) Select the type of chart
(lv) Select the chart (Column Chart)
(v) Click finish.

7| Long Answer

T s o i + | 100

Ans,

Q.

Ans.

Q 18.
Ans.

We can find the lowest score In English and Maths
by any of the following:

Drag the formula from B9 to DS,
OR

Copy paste the formula fram B9 to C9 and D9.
OR

Write formula emin(C2: C6) In C9 and emin(D2 : D6)
in DS.

Explain the Relative referencing In Calc with
example.

When you drag any formula in any row or column
In any direction, the formula gets copled In the new
cell with the relative reference. For example =Clis
an example of relative referencing, as this formula
changes automatically when we drag it vertically or
harizontally.

What do you mean by mixed referencing in Calc?
In Mixed Referencing. the $ sign Is used before row
number or column name to make It constant. For
example = C51is an example of mixed referencing,
as this formula changes only when you drag It
horizantally.

N\ Type Questions

QL

Identify the following components of LibreOffice
Calc Interface.

Ans.

Qa.
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Name of Companents are:
A - Name Box

B - Vertical Scroll Bar

C - Zoom Control

D = Quick Access Toolbar
E - Status Bar

F - Formula Bar

Answer the questions based on the following
worksheet.

(i) What is the address of the first cell represented
by Range 1?



(ii) What is the address of the last cell represented
by Range 1?
(iii) Write the cell range represented by Range 1.
(iv) Write the cell range represented by Range 2.
(v) What is the name of the cell range along a row?

(vi) What is the name of the cell range along a
column?

(vil) Write the cell range represented by Range 3.
(vilil) Give the number of cells in the cell range
represented by Range 3.
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Ans. () BS i) D5
() B5:D5 (iv) F5:FN
(v) Range 1 (vl) Range 2
(vil) B7:C12 (viir) 12

Q 3. Evaluate the following equations using operator
precedence and then test the result in the

spreadsheet (Any 8).

(i) 8-4/2 () 5°5+8
(il)) 3+5°4 (lv) 275+8
(v) 3+2"2 (vl) 5+6°2"2
(vil) 8/4°4 (viil) =-4/2+2
(Ix) 1+272-2 (x) 4°3/2

Ans. (I) 6 () 33

(1) 23 (lv) 40

(v) 7 (vi) 29
(vii) 8 (vii) O

(ix) 3 (x) 6

Q 4. Explain the following functions with examples:

() sum (ll) average
(il)) max (iv) min
(v) count
Ans. (i) Sum: This function adds the values contalned In

a range of cells. Far example = sum(A1: A5) will
add all the values of cell Al, AZ, A3, A4 and AS.

() Average: This function finds out the average
of the values contalned In a range of cell For
example =average(Al: A5) will return the average
of values present In cell Al, A2, A3, A4 and A5.

(iii) Max: This function return the largest value
contained in a range of cells. For example
=max(Al : A5) will return the largest value
present in cell Al, A2, A3, A4 and AS.

(iv) Min: This function return the smallest value
contalned in a range of cells. For example
=min(Al : A5) will return the smallest value
present in cell Al, A2, A3, A4 and AS.

(v) Count: This function counts the number of non-
empty cells within a range of cells. For example
=count(A1: AS) will return 5. if all cells contain
some any value.

Q 5. Write the output of the following on the basls of
the given screenshot (Any four).
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(i) =SUM (A1,B1,C1)
(i) =SUM(A1:C1)
(i) =SUM(A1:C1,B2)
(iv) =SUM(B1:C2)
(v) =SUM(A1:A3,C1:C3)
Ans. (1) 17
(ili) 24
(v) 37
Q 6. Write the output of the following on the basls of
the given screenshot (Any four).

(in 17
(lv) 23

il Ungistad 1 - LituaOffica Cole @] et
fite  Edid New  [ooen  Fgme!  Styles  Shoeot Qula Jool w X
wm-B-B- D@D XHHa >
Ubantion Sans ﬂ 10 pt El B | U -~. »
T
1 |
N 5 7 1 il EI
: : ; % 4
; 1 ] 5 2 ) Lﬂ@
(ifl ¢ b bl 4 Shostl  Shoot2  Shootd 1 @
| ShootBofd] Datault] Englion Gngia)] 1] @] | = 3 |

(i) =AVERAGE (A1,B1,C1)
(i) SAVERAGE (A1:C1)

(iii) =AVERAGE (A1:C1,B2)
(iv) =AVERAGE (B1:C2)
(V) =AVERAGE (A1:A3,C1:C3)

Ans. () 5.66 (i) 566
(Ill) 6.33 (lv) 5.75

(v) 616



Q7. Write answers for the following queries using

(i) Write the formula in E2 to find the total marks

functions (Any four). scored by HARMAN.

_ (i) Write the formula in F2 to find the average
|:'|"|r ekl 1 = L lnatxiliea Cale = ) b

'j"j ’ _ | Ll | , marks scored by HARMAN.

il i o i i, vincli (il) Write the formula in cell B7 to find the highest

1] - =] - .. 2 | i [ﬂ - _ _ L;'"::) - ]

d-Bk- 0 e @'_LXJ BB a s score in Hindi.

wouionsans  v|jept o] BT U« A - -] (iv) Write the formula in cell BB to find the total
B M| Jx L - = suown e ) number of students who appeared in Hindi?
n-_ bl 0| % [E] (v) Write the formula in cell B9 to find the lowest

STUDENT NAME | HINDI |ENGLISH| MATHS .

2 HARMAN 77 76 i A gcore In Hindl.

3 JAYANT 7l 15 B0

a UYA 75 07 7 o Ang. () =sum(B2:0D2)

5 AVIRAL o7 68 76 . :

7 e i % 7y © (Il) =average(B2:D2)

7 — (i) =max(B2: B6)

@ b b A Sl Gwed Shootd _ Shosd Jx (iv) =count(B2:B6)

Shostdald | Daefsall | Enpihih (ladi) | ©] O - ' + | 10 (‘u’) :mkn(BZ : 86)

Q 8. Create the following worksheet in calc and write the formula for the task glven below (Any four).

i) Untitled 1 - LibreOffice Cale - O X
Eile Edit View |nsert Format Styles SJheet Pata  Jools Window Help X
m-E-B- ORI XHDER-4E LD O &b | »
Liberation So v!| [10pt |v|| vl AL » === = = £ 5
iberation _n*i - pt | B I U +| il 8 === To e
G2 v fx Z v — ‘ ‘ v B
A 8 c D E F K Y

1 NAME MATHS |SCIENCE |[ENGLISH |HISTORY |[SANSKRIT| TOTAL

HARMAN 86 84 57 71 82 %;;
3 ANKUR 89 79 84 78 85
4 DIKSHA 52 56 69 84 59 ol
5 MANISH 40 86 36 74 69
6 HARSHITA 89 43 42 63 76 @
4 SHEETAL 52 85 40 34 67
8 JYOTSANA 84 65 71 88 81 f}{
g W
< >
4 4 b bl ==  Sheetl Sheet2  Sheet3 Sheetd  Sheet5
Sheet 50f 5 | Defoult | English (India) | oI @ | =- f——ee 4 | 100%
(I) Enter the formula In G2 to calculate the total marks scored by Harman.

(i)
(1)
(iv)
(v)
(vi)

Ans. (I) =sum(B2:F2)
(l) =average(B2:F2)

iii) =max(C2: C8)

Enter the formula in H2 to calculate the average scored by Harman.

Enter the formula In B9 to find out the highest score obtained for sclence.

Enter the formula in B10 to find out the lowest score obtained by students in each subject.
Enter the formula In B11 to find out the number of students present for each subject.
Enter the formula in B12 to find out the average score of each subject.

lv) Write formula =min(B2 : BB) In B10 and then drag harizontally till F10.

(
(
(v) Write formula =count(B2 : B8) In B11 and then drag horlzontally till F11.
(

vi) Write formula =average(B2 : B8) in B12 and then drag horizontally till F12



Q 9. Create the following worksheet in calc and write the formula for the task given below (Any eight).

il Untitlad 1 - LibsaOffice Cole O X
File [Edit  Yiew |nsart  Fgrat  Stykes  Sheet [ota Tooh  Window  Help *
HE-B-B- D8RI XD B2 A DO G5 BB »
oonss ——— Ene BT U-A-BIESSIFLLIEIEEEB »
A1 v S Lo =[sno. - —|v| =
8 C D E F G H ~ B
S. NO. NAME BASIC SALARY | TA(696) | DA(14%) | HRA(10%) | CPF(3%) |GROSS SALARY
2 1 AMIT SHARMA 12000 %;
3 2 DEEPAK GAUTAM 9000 i
4 3 CHETNA AGARWAL 15000 E]
5 4 FIROZ KHAN 8500 s
6 5 GAGAN TOMAR 15600 @
7 6 MEENA KUMARI 9800 [ _
0 7 NIKKI KHANNA 16500 [ i
9 g TEJPAL SINGH 14600 T X
10 9 VINAY KUMAR 14900
1 10 YUSUF PATHAN 12800
12 | | v
< |
| € 4 b b 4 Sheet!  Shoet2  Shoot)  Shoodd  SheotS  Shoet6  Sheat? o
Sheot 7ol 7 | Defowlt | Englih (India) | o] | @ Avaraga : Sumu 0 st { + | 100%
() Write formula in D5 to calculate TA of Firoz Khan.
(il) Write formula in E3 to calculate DA of Deepak Gautam.
(iii) Write formula in FB to calculate HRA of Nikki Khanna.
(iv) Write formula in G7 to calculate CPF of Meena Kumari.
(v) Write formula in C12 to display the highest Baslc salary.
Ansg. (1) =6/100° C5 () =14100° C3
(lll) = 10/100 * C8 (lv) = 3/100 ° C7
(v) = max (C2:CN)
Q 10. Create the following worksheet in calc and write the formula for the task glven below (Any four).
i1]] Untitled 1 - LibraQffica Colc O X
File fdit Mew |npart Fgrmot  Styles  jhoat Dot Jools  Yindow Help X
B-5-B- D& RBIXBMR-L49-C Q% -0
Liberation Su;f. v [1_2_|3_|:_E| B I u v A «~ KA v E_ ? —E | T %*— ;1__ E Il
Al B 1B fx &~ =[fS~NO. ) R | v =
B C D 3 F G gy
S.NO. NAME HINDI [ENGLISH |[SCIENCE| MATHS | BIOLOGY
2 1 AMIT 65 84 33 30 69 A,
3 2 DEEPAK 31 41 87 57 35
4 3 CHETNA 77 48 72 35 65 r@
5 4 FIROZ 76 79 33 73 76
6 5 GAGAN 41 93 62 87 28 . @
74 6 MEENA 90 84 92 43 54
g 7 NIKK]I 30 90 39 44 50 fx
9 8 TEJPAL 93 74 42 84 48 [
10 9 VINAY 62 81 74 93 86
n 10 YUSUF 27 27 28 61 48 ;
12 J' v
< > |
4 4 b p == Sheetl  Sheet2  Sheet3  Shoetd  SheetS  Sheet6
Sheet 60f 6| Dedoult | English (India) | | ol @ | Average: ; Sums 0 = 0 + | 100%




(i)

(ii)

(iii)

(iv)

(V)
Ans. (I) = sum (C2:G2)
(il) = min (C6 : G6)

(v) = sum (C7 : G7)/500 * 100

Write formula in H2 to calculate total marks of Amit.
Write formula in C12 to calculate minimum marks in Hindi.
Write formula in H6 to display lowest marks of Gagan.
Write the cell range which has marks of Nikki (of all subjects).
Write formula in H7 to calculate percentage of Meena.(Assume all marks are out of 100)
(If) = min (C2: C1)

(lv) Cell range Is CB : G8

Q 11. Create the following worksheet in calc and write the formula for the task given below (Any four).

i} Untitled 1 - LibreOffice Cale O b
Eile Edit  View |nsert Fgrmot  Styles  gheet Dota Tools Window Help X
n T d TN i e L

B-B-B- 0D R XBEs 9 Q0 BB B0 »

;Libemtinn Sang ?] ;:'12 pt H: B I u v ﬁ v l"@ v | EE % —:_:t ? i?- E— E b

AT ol fu X » =[sno v | =
B C D 3 F G “'fi

S. NO. NAME HINDI |ENGLISH |[SCIENCE| MATHS | BIOLOGY

2 1 AMIT 65 &4 33 30 69 A/

3 2 DEEPAK 31 41 87 57 35

4 3 CHETNA 77 48 72 35 65 G

5 4 FIROZ 76 79 3 73 76

6 5 GAGAN 41 03 52 87 29 ©)

7 6 MEENA 00 84 92 43 54

B 7 NIKKI 20 00 30 44 59 o

9 8 TEJPAL 93 74 a2 84 48

10 ) VINAY 62 81 74 03 86

1 10 YUSUF 27 27 28 61 48 __

12 | i o

< > )

4 4 b b <= Sheetl  Sheet2  Sheot3  Shootd  SheotS  Shoot6

Shoot 60§ 6 | Defoult | English (Indin) | oIl @ | Averoge: ; Sunu 0 e (- + | 100%

(I) Write formula in B12 to calculate total number of students.

(1) Write formula in H9 to calculate the 10% of total marks of Te)pal.
(I1l) Write formula in 112 to calculate average marks of Sclence subject.
(iv) Write formula in H2 to calculate total marks of subject English, Maths and Blology of Amit.
(v) Write formula in H4 to calculate the average of best three marks of Chetna.

Ans. (l) = count (B2 B1)
() = average (E2: EN)
(v) = average(C4 + D4 + G4)

(i) = (C9 + D9 + €9 + F9 + GI) * 10/100
(v)= D2 + F2 + G2

Q 12. Create the following worksheet in calc and write the formula for the task glven below (Any Eight).

il Untislod 1 - LibieOifice Calc O X
file [dd New Jnaort Fgoosdl  Siplas fhest Bula Jools » X
R e
w--B-D@RI X HGE-2 4 >
Uboichion Sang VJ ?\E pt :_ B | U - A .
,"*_1 3 fx 2 = =[sno. |v' =
B c D |'|.|:.:: E
S.NO. |ITEMNAME | PRICE QTY .
g 1 PENCIL 4 20 Ay
3 2 RUBBER 3 10 e
d 3 COPY 25 30 fim
5 i BOOK 150 U
6 5 EOARD 45 15 @
< > ﬂ ‘ f}(
4 4 p M =4  Sheot]  Sheet2  Shoetd  Shoold S
Sheat20f 7| Dofoult| English (indw) | @] | &1 | = il +




Write formula in E2 to calculate the Total price (Quantity ® Price) of Pencil.
Write formula in C7 to calculate total of Price values.

Write formula in D7 to calculate maximum value of column ‘QTY",

Write formula in C8 to calculate average of Price values.

Write formula in C9 to find lowest value of column PRICE"

= C4 ° D4 will return ..cnnecrncninienns £

(vii) Write the cell range of all the numerical values of column 'QTY",

(viii) Write the cell address which stores largest/maximum value of column 'PRICE.

)
(i)
(ili)
(v)
(v)
(vi)

Ans. (i) =C2°D2

(ix) How many values are stored in range C2 : D67

(iv) = average (C2:C6)

(vil) D2 : D6 (viil) C5

(i) =sum (C2: C6)
(v) =min (C2:C6)

(iii) = max (D2 : D6)
(vl) 750
(Ix) 10

CHAPTER TEST

Multiple Choice Questions

Fill in the Blanks

QL Eneﬂnnaume sheet optlon is available In.......ueeoommsianseees Q9. Numbers entered into a cell are automatically
a. Flle b.Edit  mmmsnmssnseoes i-]“gl"lﬂd.
c. Format d. Sheet Q 10. IfA1:AS contain the numbers 16,10, 3,25 and 6 then
Q 2. Extenslon of LIbreOffice Calc file 18 ....coovcveennsuccanennnans = Aygraga(Al:AS ;60) will diﬁplﬂy llllllllllllllllllllllllllll .
a. .ods b. xls
. el 4 NreaP i HIL B oaanasieiaig refarencing, the reference
Q3. To Insert the column before any column select changes rows and columns automatically when it s

Q4.

Qs.

lllllllllllllllllllllllllll

b. Sheet — Insert Columns — Columns right

C. Sheet — Insert Columns — Columns

d. None of the above

Evaluate the following expression, if cell A1, B1 and
C1 has values 10, 20 and 30 respectively.

mAl " Bl - C1

a. 170 b. 100

c. -170 d. None of these

Evaluate the following expression, if cell A1, B2, C2
and D3 has values 10, 2, 3, 36.

copled to a new cell.

Assertion-Reason Type Questions

Directlons (Q, Nos. 12-13): In the questions glven

below, there are two statements marked as Assertion

(A) and Reason (R). Read the statements and choose the

correct option.

a. Both Assertion (A) and Reason (R) are true and
Reason (R) Is the carrect explanation of Assertion (A).

b. Both Assertion (A) and Reason (R) are true. but
Reason (R) ts not correct explanation of Assertion (A).

=(D3/(A1+B2))"C2
i G4 b 216 c. Assertlon (A) Is true, but Reasan (R) Is false.
& 27 d. 125 d. Assertion (A) Is false, but Reason (R) Is true.

Q0. i, Is the function in LibreOffice Calcto  Q12. Assertion (A): Spreadsheet software is utilised for
get the sum of range of cells. manipulation of data and creation of workbook
a. ADD() b. SUM() . i / R—
- Pl S I Mo b es comprising one/more related workshee 5

Q 7. Which of the following will return the sum of Cell Al Reason (R): Cell Reference Is used for Identifying a

Q8.

to E1.

a. =SUM(A1: E1)

b. =(A1+B1+ Cl+ D!+ El)

c. =SUM(A1B1.C1.D1.EY)

d. All of these

Which of the following function calculate the

cell or a range of cells, in a worksheet. References
help to look for the values which are to be used Iin
a formula in different parts of a worksheet.

Assertlon (A):
out calculations that involve basic arithmetic

Q 18. Functions are used to carry

average In LibreOffice Calc? operations such as addition, multiplication,
E: EEEIEJRGE( ) subtraction and division.

c. Both a. and b.
d. None of these

Reason (R): The Title bar displays the sheet
information as well as the insertion point location.



Case Study Based Questions

Q14. The Spreadsheet Operators perform actions on

numeric values, text or cell references. There are
four different types of Spreadsheet Operators.
These are: Arithmetic Operators, Text Operator,
Comparison Operators and Reference Operators.
To perform basic mathematical operations
such as addition, subtraction, or multiplication,
combine numbers or produce numeric results,
use the arithmetic operators. The Comparison
Operators are used when defining conditions.
The Reference Operators are used when referring
to ranges within a spreadsheet.
A formula1s an expression that operates on values
in o range of cells or a cell. Functions are pre-
defined formulas in spreadsheet. They eliminate
laborious manual entry of formulas while giving
them human-friendly names.

() Which operator in the given expression has the

(1)
(i1)
(iii)

(iv)
(v)

What do you mean by LibreOffice Calc?

What is the use of ODD() function?

What is the purpose of the Quick Access toolbar
in Calc?

What is the use of IF function?

What are Arguments?

Very Short Answer Type Questions

Q 16. What do you mean by Function in Calc?
Q 17. Write the shortcut to open Format cell dialog box.
Q 18. What is fill handle in Calc?
Q19. Write the shortcut for the following:
1. Copy the formula
2. Paste the formula
Q 20. What do you mean by Referencing in Calc?
Q 2. Name the three types of referencing in Calc.

Short Answer Type Questions

Q 22. How will you find the highest score In Hindl, English

highest priority?
©5+6°2"2
a. b. "
¢ d. None aof these

(I) Which of the following operator has the highest
priority?
a. () b. &’ d. +

(i) If we fargot to put the '=' before the formula, it
will be treated as @.....ccummmiiscconsssnnss
a. Value b. Function
c. Label d. None of these

(lv) When we enter an equal sign ('=') In any
cell, then ...... e DAT gOtS activated
automatically.
a. Formula b. Formatting
c. Menu d. None of these

(v) Which of the following Is a valld way of writing
formula?
8. F2oB1+ (] b. =Bl + Cl

¢. Both a. and b. d. None of these

Q15. Calc is a spreadsheet program used to record
and analyse numerical and statistical data,
LibreOffice Calc provides multiple features to
perform various operations like calculations,
pivot tables, graph tools, macro programming,
etc. It is compatible with multiple OS like
Windows, macOS, Android and iOS.

A Calc spreadsheet can be understood as a
collection of columns and rows that form a
table. Alphabetical letters are usually assigned
to columns and numbers are usually assigned Lo
rows. The point where a column and a row meet
is called a cell. The address of a cell is given by
the letter representing the column and the number
representing a row,

and Maths?
0] Uit 1+ Litssaltlicn Cilg - B
flo  [da Sew joert Fprmot  Stides Sheet ol Jeoh  Mindoo  Hep ¥
W--H--0D@RXDE e &9 >
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STUDENT NAWME HINDI |ENGLISH | MATHS | ==
2 HARMAN T7 70 5 Ay
| ] JAYANT T Th 1] | =
4 RIY A Th 07 14 =]
5 AVIRAL 07 () 10
[ 0 HRIDAY (D 14 71 (@)
1 ' =
¢ > i fk
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Q 23. Name and explain the three types of data that can
be entered in a cell.

Q 24. Create the following worksheet in calc and write the
formula for the task glven below.

] Usitlad 1 - LibraOffge Cale = a X
fle [Edt Mow [nsart Fgrmot  Stdes Sheet DRoln  Joobs » K
wW--E- D@ XBR 2 4 %
Libeusion Sans ?_I 12 pt T B I U~ .& v
e _j fx L v =(sno ."‘ i
F B C D “:,'”
S.NO. |[ITEMNAME | PRICE QTY

2 1 PENCIL 4 20 %9
3 2 RUBBER 3 10 .

4 3 COPY 25 30 B
5 A BOOK 150 i

4

g B BOARD 5 15 ul @
< > | e
LA P 4 + Sheetl  Sheet2  Sheetd  Sheetd  §
S!malzaf? Defoult | € Englith {indha) | ©1 @ | - J +




(i) =C4° D4 will return .....ccceeveiiccrinnicsinnen (iii) =MAX(A1:C1)
(ii) Write the cell range of all the numerical values of (iv) =MAX(A1,B1:C2)

column ‘QTY". (v) =MIN(A1,B2,C1)
(il) Write the cell address which stores largest/ (q26. Write the output of the following on the basis of the
maximum value of column 'PRICE" given screenshot (Any four).
(iv) How many values are stored in range C2 : D67 il Untitad 1 - LibreOMica Cote i 0 %
Long Answer Type Questions Bile  Edit  Maw  |nsort Fgrot  Styles  gheet [uta Joobs » X
o | |
Q 25. Write the output of the following on the basis of the m-E-E Do [ K i | & 2
given screenshot (Any four). ,meumﬂm j] o E| Bl 1 U - =
il Urtitled 1 - LisraOl¥ice Cale - 0 % — —— o=
File [dit View |noort  Fgevwd Stgles  Shoet [ota Jooh B X imhbd H j*"‘: Z i -:5— — 7_“! i
(™1 ~ fe H [} il ==
I = ] @ o D}r @ E(rl '.'X‘.\ EE] |'.-"'I é > 5 5 7 il _-
ez Flloa BBl T L. » ; ! ! : A
Ny Bl B L= (v | = : 1 i 5 2| 1
“:'i < >
| E i 4 + Sheetl  Sheet2  Shootd @
%? Shmﬂﬂcﬂ.’l Dm'nu{rs Eaglith [indin]| ol | | - il
3 | | I W (i) = MIN(A2:C2,83)
4 >
O S o _sheus @] (i) = MINALCY)
dhost Bof 1| Defouit | Brglieny Gnaioy | o | 0] — g (iii) = MIN(A1,B1:C2)
(i) = MAX(A1,B2,C1) (lv) = COUNT(A1,B1)
(i) = MAX(A2:C2,B3) (v) = COUNT(A1:C1)
Q 27. Create the following worksheet in calc and write the formula for the task glven below (Any four).
[} Uwtinbusd 1 - LoaaO1lica Cale =] X
Fie  fdit Maw oot Fgrnst St jheet  [ota Jools  Wandow  Halp %
M- D8R X 0GB A &, SRCHBCEC A A RV
Uborsion Sons Mo FiB T U-A- SESIFAHLSEEER A
st Pl xD-=[sno v | m
i C D E F G H ey =]
S. NO, NAME BASIC SALARY | TA(650) | DA[14%6) | HRA(1030) | CPF(3%6) |GROSS SALARY
2 1 AMIT SHARMA 12000 : Ay
] 2 DEEPAK GAUTAM 0000 .
4 ] CHETNA AGARWAL 15000 o
5 A FIROZ KHAN BE00 ] |
6 5 GAGAN TOMAR 15600 B ®
7 6 IAEENA KUMAR] 9800 ._
g 7 NIKKI KHANNA 16500 8 I
9 0 TEJPAL SINGH 14600 L i
10 D VINAY KUMAR 14000
1 10 YUSUF PATHAN 12800
2 | | v
c1 > |l
L) b bl == Sheat srmmz Shoetd  Sheod  Sheats  Showll f Shoﬂ?_
Shoot 7eA7 | Dafaait | anlnh (inalin) | |23 @ | Avong e 1 Gumu O |- 0 + | 00

(i) Write formula in 110 to calculate the gross salary of Vinay Kumar.

(i1) Write formula in H12 to calculate the average of Gross Salary of all employees.
(ili) Write formula in B12 to display the total number of employees.
(lv) Write formula in 111 to calculate average of TA, DA and HRA of Yusuf.

(v) Write formula in C13 to calculate the sum of Basic Salary of all employees.



